
Morpheus Photo Mixer™

Reviewer’s Guide
Morpheus Photo Mixer is easy-to-use compositing software 
that mixes up faces and body parts between two photos.

Included in the Reviewer’s Guide:

•  Screenshots
•  Tutorial
•  FAQ

Tutorial

Loading Pictures

Start Morpheus Photo Mixer by clicking on the icon either on your 
desktop or in the Start menu. If you are in the right program, the 
corner of the screen should resemble this picture. 

Screenshots



You should see the Layout Wizard when you first start Morpheus 
Photo Mixer. 

If you need to access the Layout Wizard at any time, it can be found 
in the File menu. 

In this tutorial, we will create a simple photo mix.
Select "Create a new photo mix layout." from the first page of the 
wizard, then press the Next button to continue. 

In this example, the "young girl.jpg" sample image (included with 
Morpheus Photo Mixer) will serve as one of the pictures. 

Once the file is opened, the picture will appear in the picture preview 
box below the Load Picture button. 

Load the second picture using the button on the right. For this 
example, the "man.jpg" sample image will be used.  Click the Next 
button again.

Adding Dots

Once you finish the Layout Wizard, you will be brought into Morpheus 
Photo Mixer with a new layout containing your pictures. The two 
pictures are labeled with the tabs above each picture window. 

The next step in creating your photo mix is to place dots in both of the 
picture windows. Their placement will define how the picture will mix. 
Select the Add Dots tool from the toolbar as shown here. 

In this example, we'll start by placing a dot near the girl’s eye. It is 
recommended that you place dots around major picture elements 
such as the eyes, nose, or mouth. Click on the picture to add a new 
dot. Notice that a corresponding "partner" dot will appear 
automatically in the opposite picture window.

Here we have added a dots near both eyes, and one on each side of 
the mouth.The more dots you use, the better your resulting photo mix 
will be. The partner dots appear in the same location in both picture 
windows. These dots will need to be adjusted so that they are 
situated on the same key elements.



In order to align the dots you must select the Move Dots tool as 
shown here. This tool allows you to click and drag dots around both 
picture windows. 

Aligning Partner Dots

We want to align the dots in both picture windows so that they are 
over corresponding elements. Hovering over a dot causes it to glow 
with a colorful outline. Its partner dot glows with a black and white 
outline. Click and drag the dot to a new location, and then release 
the mouse button. 

Here we have moved the red dot over the man's right eye, since that 
dot's partner dot was located near the girl's eye in the other picture 
window. 

Move the other three dots in the same fashion as the first one. You 
can see here how we aligned all of the dots near the same picture 
elements as their partner dots. 

The Preview window is located on the right side of the screen by 
default. It can be hidden and shown by pressing Ctrl+P. The Preview 
window automatically updates your photo mix, showing your changes 
in real time. 
The Proof button will change the Preview window from draft to proof 
mode, which will show a maximum quality, full-sized preview.

You can see how well the eyes and mouth have lined up by using only 
four dots, but notice that other key features such as the nose and chin 
are blurred. This is because there are no dots on those features. 
Adding a few more dots to these areas will create an even better mix.

Previewing the Photo Mix

Here we have added a total of 25 dots to the photo mix and are 
ready to render it for use outside of Morpheus Photo Mixer.
Press the Render Timeline button on the toolbar. Rendering is not the 
same as saving your layout. Saving your layout creates a file that can 
still be altered in Morpheus Photo Mixer. A rendered file can be 
emailed or displayed in other programs, but it cannot be changed by 
Morpheus Photo Mixer.  

This layout in this final form is included as one of the sample layouts 
with Morpheus Photo Mixer.    

Rendering the Photo Mix



At the Save As window, you can select a location to render your 
photo mix to, enter a name for the file, and select a file type to 
render to. 

Enter any file name you wish, but make sure you remember which 
folder on your hard drive you saved your photo mix into.

JPEG and PNG formats are the best for displaying on webpages. 
Select a format from the "Save as type" dropdown menu.  

 After a brief rendering progress window, your photo mix file will be 
created and ready for viewing. 

Fading dots is an optional step you can use to further improve the 
look of your photo mix. However, this requires Morpheus Photo 
Mixer Professional with beginner mode menus unchecked. For this 
example, we are starting with a different photo mix, which is 
included with Morpheus Photo Mixer.

With just the default options, Morpheus Photo Mixer mixes the two 
pictures 50/50, combining all of the features from each image 
together into one. 

If you want to use specific features entirely from one picture for 
some parts, and features from the other picture for other parts, then 
you will need to use the "Fade Selected Dots" option. 

(Pro) Fading Dots

First, use the Select Dots tool to select the dots near the picture 
features that you want to come from just one of the pictures. 

Here we are selecting all of the red dots around the top of the head 
and nose. 



1. What is Morpheus Photo Mixer?
Morpheus Photo Mixer is an award-winning graphics program that lets you create mixes of characteristics from 
two photos and render them in JPEG, PNG, TIFF, and other popular formats. It is easy, fast, and fun to use for 
both beginning and advanced users.

FAQ

2. What are beginner mode menus?
By default, Morpheus Photo Mixer is set to beginner mode.  This hides all but the bare essential menu choices 
needed to create a simple photo mix. This is to familiarize new users with the basics of the program.
To use the normal mode, uncheck the beginner mode checkbox from the layout wizard, or select it from under 
the Edit menu. Normal mode will show all available menu options and tools available to Photo Mixer users.

With the dots still selected, click on the "Fade Selected Dots" button 
on the toolbar and pick End. By default, all dots are faded to Blend 
Pictures. We want the head and nose features to come from the 
picture of the dog, which is in the picture window labeled End. This is 
why we selected End from the three choices. 

Next, we repeat the same process for the green dots, but fade those 
to Start so that most of the rest of the baby picture will come through. 

The yellow dots were left at the Blend Pictures default to create a 
smoother transition between the various parts of the photo mix. 

Here you can see the final mix of a baby with a dog nose and 
dog ears. 

 

3. Why are some of my dots the same color?
In beginner mode, you are fixed with a cycle of 8 basic dot colors. You will inevitably have several dots that are 
the same color. To tell the dots apart and to correctly locate their partner dot, highlight one with your mouse. 
Its partner dot will highlight as well. You can change the color, style, and dot size by selecting Customize Dot's 
Default from the Morph menu.

4. What is the best way to view my photo mix when I am finished?
When you have finished creating your photo mix you can view it for yourself right inside the program in the 
preview window.  You can render your photo mix to many picture formats such as JPEG, PNG, or TIFF which 
can be viewed in a variety of applications. 

5. In what formats can I render my photo mixes? Which is the best?
You can save your photo mix to any of these picture formats:

•  PNG: Perfect quality images, small file size, and supports full transparency.
•  JPEG: Very small files good for webpages, but quality poor at higher compression settings.
•  TIFF: Perfect quality images, large like bitmaps.
•  BMP: Perfect quality shot of every frame, but very large files.
•  TGA: Perfect quality, large, but supports transparency in more programs.
•  XPM: Larger than all other formats, but useful for importing to Linux systems.

Which file type is the best depends on what you want to do with your photo mix. If you are unsure, you can try 
each of the formats and see how they work with the other programs.



6. What do I do with my completed photo mixes?
Use your photo mixes to grab people's attention - enhance your web site, email photo mixes to friends and family, 
create a unique online greeting, post them on the Internet, and add more life to your presentations
If your photo mix is unique and exciting, you might consider submitting it to us for display. 

7. How can I email my photo mix to a friend?
You can email your mixes using the built-in email feature by selecting "Email your morph to a friend" from the 
Share menu in the program. The Send Morph Wizard will appear, allowing you to fill in your From address and 
any number of recipient addresses.

You can also attach that file to an email in your regular email program just like you would any other file you 
wanted to send. Smaller files, such as JPEG, work best. 

9. What are the best picture sizes to use?
It is recommended that you use pictures with large dimensions. The more detail you have to work with, the better 
your results will be. Remember to use pictures with similar aspect ratios to avoid unwanted stretching.

10. Can I add dots to just one picture individually?
Every dot added to one picture will automatically get a  partner dot on the opposite picture.  Dots only come in 
pairs, the purpose of which is to match up and mix corresponding points in each picture 

11. I closed the picture windows. How do I get them back?
In the Timeline window, simply doubleclick on any of the picture thumbnail buttons to open that picture window. 
When doubleclicked, the photo mix buttons just above the picture buttons will open both pictures for that photo 
mix side by side. Select the Timeline window from the View Menu if it is hidden.

12. What is the difference between a morph, a warp, and a photo mix?
A morph is an animation of one photo transitioning into another. A warp is an animation where one picture is 
stretched or distorted. A photo mix is a still picture which is created using parts taken from two other pictures.
Morpheus Photo Mixer is used to create photo mixes. In order to create morphs, you would need the 
functionality of Morpheus Photo Morpher. In order to create warps, you would need the functionality of 
Morpheus Photo Warper. However, all of these features are available with Morpheus Photo Animation Suite. 

13. How does the Fade Selected Dots button work?
By default, in a photo mix the entire mix is a blend of both the starting and ending picture. Each dot can be set to 
use the picture colors entirely from one picture by selecting start or end from the Fade Selected Dots button 
when you have one or more dots selected. Morpheus Photo Mixer automatically creates smooth mixes by 
blending between each dot set with different fade settings.
 
If, for example, you wanted to blend the head from the starting picture onto the body from the ending picture, you 
would select all of the dots placed around the head on the pictures and select Start from the Fade Selected Dots 
button, then select End for the dots around the body. The dots in between the head and the body can be set to 
Blend if you want a smoother transition. 

14. How can I keep transparency in my rendered files?
Morpheus Photo Mixer by default only renders 24bit truecolor images for each frame, but if you check the "Morph 
the alpha channel" option in the Timeline Options window, then a 32bit image with alpha channel will be rendered 
for each frame. If you wish to keep the entire alpha channel information intact, you should set the "Transparent 
threshold" to 0. PNG is the best format for keeping the alpha channel intact, allowing it to be blended seamlessly 
into any web page background. 


